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Instructions for Converting Omniform to Formdocs 

Formdocs Application Note Updated 05/29/2018 

 
 
 
This document provides instructions for converting both an Omniform design file and an 
Omniform data file to the corresponding Formdocs file format so that you can use 
Formdocs for your form-filling solution going forward.  
 
Note that if you do not want to carry over to Formdocs any saved information in your 
Omniform data files then you can ignore the section on Converting Data Files.  
 
The following instructions assumes the reader has a working knowledge of Omniform.  
 
In order to perform conversions you must have Formdocs SCAN & FILL, v10.0 or higher, 
installed on your computer. 
 
 
Suggestion: If you have never before created a form template in Omniform Designer or 
Formdocs Designer, it is strongly suggested that you first invest 30 minutes in taking the 
Formdocs Designer Tutorial. On the Help menu of Formdocs Designer, click Formdocs 
Tutorial to launch the tutorial. At the completion of the tutorial you will have familiarity 
with the commands and tools necessary to complete and adjust the conversion of your 
Omniform form template to the Formdocs format. After you complete the tutorial you 
can resume reading this document. 
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How to Convert an Omniform Form to a Formdocs Form Template 
 
Formdocs SCAN & FILL Designer offers three (3) different methods for you to convert 
your Omniform design file (*.ofm) to the Formdocs form template format (*.fdt).  
 
The reason for providing three methods is because the accuracy of the conversion 
process depends on the complexity of the Omniform being converted; some conversion 
methods work better than others for a given form.  
 
For example, if after you try converting with method #1 you are not satisfied with the 
accuracy of the conversion, you can retry the conversion using method #2; if that 
doesn’t produce satisfactory results then you can try method #3. Sometimes it is best to 
try all three methods and then choose to work with the resulting converted form that 
displays the best results.  
 
Note that regardless of the conversion method(s) you use, the conversion will rarely be 
100% accurate; there will likely be some form design elements (fill-able fields, lines, 
boxes, text) that are mis-interpreted, missed altogether, or mistakenly created. As a 
result, you can expect that you will need to manually make such corrections using the 
Formdocs Designer form-drawing tools to draw by hand any items that were missed, or 
not created correctly and, in some cases, you may need to simply delete an item. To 
make these post-conversion tasks easier to perform, Formdocs Designer provides a 
Proofreader; a guided step-by-step tool that focuses you on specific tasks, all of which 
are described later in this document. 
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To begin, choose the scenario which applies to you and then perform your choice of the 
available conversion options listed. Note that you can perform as many available 
conversion options as you want, to see which produces the best result. 
 
 

“I Have Omniform Running on Windows XP…” 
 
“and I have a PDF printer installed.”  
Follow the instructions for Conversion Method #2. 

  
“and I have a hard-copy printer attached.”  
Follow the instructions for Conversion Method #3. 
 
 
 

“I Have Omniform Running on Windows VISTA, 7, 8, or higher…” 
 
“and I have access to my Omniform *.ofm files”  
Follow the instructions for Conversion Method #1. 
 
“and I have a PDF printer installed.”  
Follow the instructions for Conversion Method #2. 
 
“and I have a hard-copy printer attached.”  
Follow the instructions for Conversion Method #3. 
 
 
 

“I Can No Longer Run Omniform on any computer… “ 
 
“and I have a blank copy of my original paper form.”  
Follow the instructions for Conversion Method #3. 
 
“and I have saved copies of my Omniform *.ofm files.”  
Contact Formdocs for a professional services quote to have our staff convert your Omniform design 
file to a PDF document so that you can use Conversion Method #2. 
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Conversion Method #1 

You will print your Omniform to a Formdocs-provided print driver which will create 
converted output. You must have the “Print to Formdocs” print driver installed. 

 
1. Install FormDocs SCAN & FILL on the same computer running Omniform. 

2. Start Omniform Designer. 

3. Open the Omniform design file (*.ofm) you want to convert to Formdocs. 

4. In Omniform designer, click Print. 

5. In the Omniform 'Print' dialog box, open the list of available printers and select 
the printer named “Print to Formdocs”.  

(If you do not see the “Print to Formdocs” driver listed then you must close the 
Print dialog box and download the driver from  www.formdocs.com/support/ and 
install it. Then repeat starting at Step 4, above.) 

6. Click OK to print. The Formdocs Designer will start up and the Formdocs 
Document Converter Wizard appears; click Next.  

7. When the Document Conversion Wizard completes it will produce a Formdocs form 
template on the workspace.  At this time do not be concerned with any conversion 
errors you may notice, you will address those later.  

8. In Formdocs Designer, dismiss the conversion completion message, and then 
choose 'File/Save' to descriptively name and save the template file; if prompted 
by a dialog box for, “Form template properties”, press Skip. 

9. Leave open the original form in Omniform Designer so that you can refer back to it 
when necessary. 

10. On the left side of the Formdocs Designer workspace appears the FormDocs 
Proofreader. Go to the section titled, Proofreading the Converted Form elsewhere 
in this document and follow those instructions. 

- end - 
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Conversion Method #2 

You will print your Omniform to a PDF printer to create a PDF document file; you will 
then select that file as input to Formdocs Converter. You must have any third-party PDF 
printer installed. 

 
1. Start Omniform Designer. 

2. Open the Omniform design file (*.ofm) you want to convert to Formdocs. 

3. In the Omniform Print dialog box, open the list of available printers and select 
your PDF printer; choose to print All Pages and specify a descriptive file name for 
the PDF output file. 

4. Click OK to print; verify the PDF output file is saved and note its folder location.  

5. If necessary, copy the PDF document to the computer running Formdocs. Start 
Formdocs Designer; (if the User Guide appears, dismiss it.)  

6. Choose the option to Convert a Document; the Formdocs Document Converter 
Wizard appears; when prompted to choose which you want to convert, select 
PDF… and then press Next.  

7. Locate and select the PDF document you created and saved, then press Open. 

8. In the Document Converter Wizard, press Next to perform the conversion process. 

9. When the Document Conversion Wizard completes it will produce a Formdocs form 
template on the workspace.  At this time do not be concerned with any conversion 
errors you may notice, you will address those later.  

10. In Formdocs Designer, dismiss the conversion completion message, and then click 
Save to descriptively name and save the template file; if prompted by a dialog box 
for, “Form template properties”, press Skip. 

11. On the left side of the Formdocs Designer workspace appears the Formdocs 
Proofreader. Go to the section titled, Proofreading the Converted Form elsewhere 
in this document and follow those instructions. 

- end - 
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Conversion Method #3 

You will scan a paper copy of your form into Formdocs Converter. You must have 
attached to your computer a WIA or TWAIN compliant scanner that can acquire a 
grayscale image. 

 
1. Start Formdocs Scan & Fill Designer. 

2. Place your paper form in the scanner. When using a flatbed scanner, butt the 
entire edge of the face-down paper squarely against the left edge of the flatbed, 
then align the edge of the paper to the correct paper-size tick-mark on the 
flatbed. Note that best results will be had when you take the time to carefully 
place and align the paper on the flatbed as described.  

3. On the Tools menu, choose Convert... The Document Converter Wizard appears.   

4. Choose Paper document in my scanner, and then click Next.   

5. Note that if you already have a form template open on the workspace it will 
prompt you to choose whether the scan should result in adding a page to the 
existing form template or if it should create a new form template; make a choice 
and click Next. 

6. Specify the correct paper size and orientation of the document you want to scan, 
then select where on the scanner you will place the paper document (Flatbed or 
Sheet-feeder). If your document contains any color logo, color illustrations, or 
colored text you want to keep, select the checkbox, Contains Color. Click Next.  

7. Click Next. (Note that if you chose a Custom paper size then your scanner will 
prompt you for options; also, some scanners display their own user interface when 
you scan from FormDocs; choose a minimum of 300 DPI (600 DPI if characters 
are very small) and Grayscale if your document has no color, otherwise choose 
Color, and then start scanning.)  

8. Formdocs will begin scanning your document.  

9. When scanning completes you will see the image of your scanned document 
appear on the workspace, and a Document Conversion Wizard will appear in a 
sidebar. Read the brief instructions at each step and use the controls to make any 
necessary adjustments to the image on your workspace. Visit each step by clicking 
Next.  

10. When the Document Conversion Wizard completes it will produce a FormDocs 
form template on the workspace.  At this time do not be concerned with any 
conversion errors you may notice, you will address those later.  

11. Click Save and enter a descriptive file name for your form template.  

12. On the left side of the Formdocs Designer workspace appears the Formdocs 
Proofreader. Go to the section titled, Proofreading the Converted Form elsewhere 
in this document and follow those instructions. 

- end - 
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Proofreading the Converted Form 

The Formdocs conversion process does its best to convert your Omniform to a Formdocs 
form template. The result of that conversion (lines, fields, text, etc.) appears on the 
Formdocs Designer workspace. However, there is still work to be done as the conversion 
process does not carry over all of the properties and settings of your original Omniform. 

Additionally, the conversion process is rarely 100% accurate; typically, the conversion 
process may miss, or misinterpret, some items. 

As a result, you will need to use Formdocs commands and drawing-tools to make any 
corrections and enhancements to the form template. 

To make these post-conversion tasks easier to perform, Formdocs provides a 
Proofreader feature which guides you step-by-step so that you can perform each task in 
a logical order. 

It is suggested that you follow each Proofreader step starting with the first and then 
pressing the Next Step button at the end of each step. Note that you can also randomly 
go to any Proofreader step by clicking it in the list. 

 

Design 

This is the default workspace view that lets you use all the form-drawing tools, 
menus, and commands to draw, manipulate and configure fields, text, lines, and 
graphics. The full functionality of FormDocs Designer is made available in this view.  

Note that the conversion process is never 100% accurate and you will likely need to 
use this Design view and its form drawing tools to restore any missing fields or text, 
or use commands to move or re-size fields, re-format text, or delete extraneous fields 
or graphics. 

  

Design File Conversion Limitations 

Some Omniform objects have no corresponding match in Formdocs so they will 
require special handling…  
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Circle Text – Formdocs does not provide a circle-text drawing tool however, an 
Omniform circle text field can be substituted with either a Formdocs option button or 
checkbox field with the label positioned adjacent to the field. 

                                 

If you need to ensure only one choice is made, select all buttons or checkboxes, then 
on the Arrange menu choose Group Options. 

 

Comb – Formdocs does not provide a comb-drawing tool however, the Formdocs 
Conversion process does dynamically create matching comb fields. Note that you will 
not be able to adjust the size or properties of comb fields. 

                                                  

If the conversion mistakenly creates a comb when instead you want individual fields - 
right click the comb; in the drop-down menu, choose Convert; this will convert the 
Comb into individually named fields. 

 

 

Table - Formdocs creates a different Table object than Omniform does; for example, 
in Formdocs an entire column is considered one named field even though it contains 
individual rows; in Omniform the same dimension Table is comprised solely of 
individual named fields, one for each row in every column.  

 

If you need to preserve the structure of the Omniform table in Formdocs - for 
example, because you later intend to import your Omniform records data file into 
Formdocs - right click the table; in the drop-down menu, choose Convert To-> Text 
Field; this will convert the Formdocs table into one that has all individually named 
fields just like it was in Omniform. 
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Tab Order 

The Formdocs conversion process does not copy-over the tabbing order from 
Omniform; instead, Formdocs creates a top-down, left to right order but you can 
change that back to the original Omniform tabbing order, or to any tabbing order you 
want.  

For more information, see the Formdocs Designer User Guide, available on the Help 
menu; open the chapter, “Using the Proofreader”; under the topic, Workspace Views, 
read the section Tab Order View. 

 

Field Names 

Both Formdocs and Omniform use field names to identify form fields (i.e. areas on 
the form into which users can enter information). This proofreading step displays the 
field names created for each field on the form. 

In your Omniform you may have field names that are descriptive, such as 
“CustomerName”, or you may have non-descriptive default field names that 
Omniform Designer generated, such as “Field001”, or you may have a mix of both 
types. 

The Formdocs conversion process does not copy-over field names from Omniform; 
instead, Formdocs tries to create a descriptive field name based on what the field is 
supposed to contain. For example, if a form field is labeled “Customer Name”, 
Formdocs will likely name that field CustomerName. You can choose to accept the 
Formdocs-generated field name, or you can change it back to the original Omniform 
field name, or you can create a different field name. 

Note that it is beneficial to have descriptive field names and, unless you have a good 
reason not to, it is best to assign descriptive field names to your Formdocs fields with 
the same name as the corresponding fields in the Omniform – but only if those 
names are descriptive.  

To learn the name of an Omniform field, in Omniform, right-click the field and choose 
Object Definition; view box titled, Name. Using the same descriptive name is 
especially important if you intend to later create field calculations, or import legacy 
Omniform records into your corresponding Formdocs template to create a Formdocs 
forms database that mirrors your legacy Omniform forms database. 

If you have Omniform fields with non-descriptive default field names it is helpful to 
print out that form page and hand-write in those form field names so that you can 
reference them as you re-name your Formdocs fields with more descriptive names; 
then you will later use that hand-written information as a reference to create the field 
name linkages during the Formdocs Filler data import process by selecting field 
names that display in a dialog box. For example, during the Formdocs Filler data 
import process you might need to link a non-descriptive Omniform default name like, 
“FillText1” to the more descriptive name, “CustomerName” in the Formdocs template. 

For more information, see the Formdocs Designer User Guide, available on the Help 
menu; open the chapter, “Using the Proofreader”; under the topic, Workspace Views, 
read the section Field Names View.   
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Data Entry Format 

The Formdocs conversion process does not copy-over the data-entry format of form 
fields from Omniform; instead, Formdocs creates a data-entry format based on the 
meaning of the field label, if one is present.  

For example, if a form field is preceded by a text label that is, “DOB” (Date of Birth), 
then Formdocs conversion will give that field a data-entry type of Date; that is, users 
will only be allowed to enter a date value in that field and when the form is saved, the 
value in that field will be stored as a date.  

Unless you have a good reason not to, it is best to assign Data Entry Types for your 
Formdocs fields with the same Data Entry Type as the corresponding fields in the 
Omniform. To learn the Data Entry Type of an Omniform field, in Omniform, right-
click the field and choose Object Definition; view boxes titled, Type and Format. This 
is especially important if you intend to later create field calculations, or import legacy 
Omniform records into your corresponding Formdocs template to create a Formdocs 
forms database. 

Note that if fields will be involved in a numerical calculation expression then you 
should assign those fields one of Formdocs’ available numeric data entry types, as 
appropriate; for example, Currency, Number, Percentage.  

For more information, see the Formdocs Designer User Guide, available on the Help 
menu; open the chapter, “Using the Proofreader”; under the topic, Workspace Views, 
read the section Data Entry View. 

 

 

Calculations 

The Formdocs conversion process does not copy-over any calculation expressions 
from Omniform. You will need to re-create in Formdocs any calculations that are 
present in your Omniform fields. 

To learn whether an Omniform field has a calculated value, in Omniform, click the 
Omniform field; any calculation expression will appear in the Omniform Designer 
Calculation Toolbar. Make note of any field names, operands, and operators in the 
calculation expression and create the same expression for the corresponding 
FormDocs field.  

For more information, see the Formdocs Designer User Guide, available on the Help 
menu; open the chapter, “Calculations” and read the topics, starting with “Create a 
Calculation”.   
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Automation 

Omniform has no Forms Automation feature so there is nothing to convert or carry-
over; this Proofreading step can be skipped over.  

You can learn later about how to use the Forms Automation feature to enhance your 
Formdocs form in ways that were not possible in Omniform. 

For more information, see the Formdocs Designer User Guide, available on the Help 
menu; open the chapter, “Advanced Features” and read the topics, starting with 
“Programming Information”.   

 

 

Finish 

At this step you have the option to bring your converted form template into Formdocs 
Filler to try filling it in. Or, if your converted form template has more than one page, 
you can switch to the next page and start Proofreading again on that page. Note that 
all pages in a form template need to be proofread. 

For more information, see the Formdocs Designer User Guide, available on the Help 
menu; open the chapter, “Working with Pages” and read the topics, starting with “Go 
to a Page”.   

 

At any time you can see what it’s like to enter data into the fields of your form 
template by pressing the toolbar button Preview in Filler; this will switch you to 
Formdocs Filler and open your form template so that you can tab-around, fill-in and 
save information. 

To resume working on the design of your form template, in Formdocs Filler press the 
toolbar button titled, Design; doing so will close Formdocs Filler and switch you back 
to Formdocs Designer. 

You can repeat the cycle of proofreading, correcting, and adjusting your form 
template in Formdocs Designer and then previewing your form template in Formdocs 
Filler for as many times as you want to. 

For more information on the Design and Preview cycle, see the Formdocs Designer 
User Guide, available on the Help menu; open the chapter, “Form Design Basics” and 
read the topic, “The Design-Preview Cycle”.  

 

For more detailed information on the Finish view, open the chapter, “Using the 
Proofreader”; under the topic, Workspace Views, read the section Finish View. 
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This ends the section on converting an Omniform design file to a Formdocs form 
template. You can now open your new template using Formdocs Filler; on the Windows 
Start menu, choose Formdocs Filler; on the Formdocs Filler File menu, choose New and 
select your template by name. 

Similar to Omniform, the Formdocs Filler toolbar has commands which enable you to fill-
in and save completed forms to a forms database. There are also commands to browse, 
navigate, search for, sort, and list database records. To learn more about working with a 
forms database, see the Formdocs Filler User Guide, available on the Help menu; open 
the chapter, “Forms Database Operations” and read the topics of interest there. 

 

The remainder of this document describes how to export data from your Omniform data 
file and import that data into your new Formdocs form template to create a Formdocs 
forms database that you will continue to use going forward. Note that this is an optional 
process that is important only if you want to carry over your legacy Omniform records to 
Formdocs.   
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CONVERTING OMNIFORM DATA FILES 

To summarize, you will EXPORT data as Text from Omniform and then IMPORT that data 
into your Formdocs template to create a Formdocs forms database having the same 
number of records as you had in Omniform. 

The following instructions assume Omniform v5.x. If you have an earlier version of 
Omniform you may need to match the intent of these instructions to the actual 
commands in your version. 

 

EXPORTING DATA FROM OMNIFORM 

1. In Omniform Filler open the 'File' menu and choose, Export Data; the 'Export Data' 
dialog box appears. 

2. In the 'Export' dialog box, press New; the 'Export Setup' dialog box appears 

3. In the 'Export Setup' dialog box, under "Export To", select ODBC Database. 

4. In the 'Export Setup' dialog box, press Administrator; the 'ODBC Data Source 
Administrator' dialog box appears. 

5. In the 'ODBC Data Source Administrator' dialog box, click the tab titled, System 
DSN. 

6. In the 'System DSN' panel, press Add; the 'Create New Data Source' dialog box 
appears. 

7. In the 'Create New Data Source' dialog box, scroll the list and select, Microsoft 
Text Driver (*.txt; *.csv), and then press Finish; the 'ODBC Text Setup' dialog box 
appears. 

8. In the 'ODBC Text Setup' dialog box, do the following: 

a. In the "Data Source Name" box, type the name, 
"ConvertOmniformDataToFormdocs" without any spaces.  

b. In the "Description" box, leave it blank.  

c. Under "Database Directory" place a checkmark in the box, "Use current 
directory".  

d. Press OK; the 'ODBC Data Source Administrator/System DSN' dialog box re-
appears. 

9. In the 'ODBC Data Source Administrator/System DSN' dialog box, under "System 
Data Sources" select in the list the driver named, 
ConvertOmniformDataToFormdocs, then press OK; the 'Export Setup' dialog box 
re-appears. 

10. In the 'Export Setup' dialog box, under "Available Data Sources", select the text 
driver named, ConvertOmniformDataToFormdocs and press OK; the 'Export As' 
dialog box appears. 
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11. In the 'Export As' dialog box do the following: 

a. At "Save in", select the folder where you want the exported data to go.  

b. In the "File name" box, type a descriptive name for the export file; for 
example, "Purchase Order Data Export from Omniform"; this will help you 
recognize its purpose, later.  

c. In the "Save as type" box, select Microsoft Text Driver (*.txt; *.csv), and then 
press Save; the 'Export' dialog box appears. 

 

12. In the 'Export' dialog box do the following: 

Under "Fields in:", select the Omniform fields you want to include in the export 
and press Add; if you want ALL fields to be included (the usual choice) you can 
select the first field in the list, then scroll the list to the bottom, hold down the 
<SHIFT> key and then click the last entry in the list; you will see ALL entries 
become selected and then you can press Add.  

Under "Fields to Export" will be listed all of the Omniform fields that will be 
included in the export.  

When you are done adding fields to be exported, press OK; you will be prompted, 
"What do you want to do with the export selections..."; press Run; the export 
operation will begin.  

13. If the export succeeds then you will see a message, "Successfully exported n 
records". Press Cancel. You now have a text file of your Omniform data that is 
ready to be imported into your Formdocs template. 

 

 

Continue reading the next section…  
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IMPORTING DATA INTO FORMDOCS 

Before you can perform the following steps, you must first complete the instructions at 
EXPORTING DATA FROM OMNIFORM, above. 

 

1. In Formdocs Filler, choose File/New and select the Formdocs template (*.fdt) you 
created by converting the Omniform Design file.  

2. In Formdocs Filler, choose File/Import; the 'Import From' dialog box appears.  

3. In the 'Import From' dialog box, located to the right of the "File name" box, open 
the drop-down list and choose Text. Then locate and select the text file you 
exported from Omniform, and then click Open. The Formdocs 'Import Text' dialog 
box appears. 

4. In the Formdocs 'Import Text' dialog box, select Comma as the field delimiter and 
then put a check mark in the box labeled First row contains field names; then click 
OK. 

5. If all of the fields in the file being imported exactly match all of the fields on the 
Formdocs template, a message will display, "The import file is an exact match..." 
and also prompt you to view or edit the field matching; you should choose 'No'. 
The import operation will begin, and you can skip to step 6, below. 

Otherwise, if any of the fields in the file being imported cannot be matched to any 
fields on the Formdocs form template, a message will prompt you to view the field 
matching, and you must press Match; the 'Import Matching' dialog box appears.  

In the 'Import Matching' dialog box you must match fields in the file being 
imported to fields on the Formdocs form template by selecting a Formdocs form 
field in the left column, selecting an Omniform field in the right column, and then 
clicking the Match button. Match as many fields as you desire. Note that you do 
not need to match all fields, but any fields left un-matched will not be imported. 

When you are done matching fields, click OK; the import operation will begin. 
 
6. After importing completes, click File/Save As to name and save the Formdocs form 

file (*.fdd) you just created. 

7. You may now use Formdocs Filler to navigate, add records to, search, sort, and 
list records in the new form file. 

 
- End - 


